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OMREŽNA ANALIZA TEKSTA V ODNOSIH Z JAVNOSTMI: 
APLIKACIJA EKSPLORATORNE ANALIZE SEMANTIČNEGA
OMREŽJA S POMOČJO PROGRAMA PAJEK

Povzetek. V članku se ukvarjamo z umestitvijo repre-
zentacijske analize kot metodološke dopolnitve analize
vsebine. Pri analizah medijskega pojavljanja, ki so
danes sestavni del paketa ‘analitičnih produktov’ v po-
nudbi kliping storitev, je za merjenje komunikacijske
učinkovitosti najbolj uporabljana analiza vsebine. V
odnosu do analize vsebine v članku predstavljamo re-
prezentacijsko analizo medijskega pojavljanja (RAMP),
ki temelji na eksploratorni analizi semantičnega omrež-
ja. Podobno kot analiza vsebine tudi reprezentacijska
analiza poskuša iz kompleksnega gradiva abstrahirati
ključne pomenske vzorce. Toda če je pri analizi vsebine
interpretacija in redukcija pomenskih sklopov odvisna
od spoznavnoteoretskega okvira, ki ga raziskovalec
uporabi, se reprezentacijska analiza temu izogiba in
poskuša iz samega besedišča nekega medijskega pojav-
ljanja izluščiti, kakšni pomenski vzorci v medijskem
pojavljanju obstajajo in kdo so nosilci teh reprezentacij-
skih shem. Na izbranem primeru natančno predstavi-
mo korake analize, narejene s pomočjo računalniškega
programa za analizo omrežij Pajek.
Ključni pojmi: odnosi z javnostmi, tržno komunicira-
nje, analiza vsebine, analiza omrežij, reprezentacijska
analiza, semantika, kognitivna antropologija, računal-
niški program Pajek

Uvod

V članku se ukvarjamo z umestitvijo reprezentacijske analize kot temelj-
ne dopolnitve analize vsebine v širše področje analize teksta ter njeno upo-
rabo. Na konkretnih primerih analize tvorjenja medijskih tekstov pokažemo
njena temeljna načela, prikaze in možne interpretacije. Slednje je uokvirjeno
v kontekst uporabe predlaganih analitičnih orodij v odnosih z javnostmi oz.
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tržnem komuniciranju v integralnem pomenu. Analitično orodje, ki ga raz-
delamo in predlagamo, je sicer primerno za analiziranje katerekoli kodira-
ne1 komunikacije na fizičnem prenosniku, kamor je bila zapisana oziroma
shranjena. Orodje zato lahko seže v različne kanale, tipe in kontekste komu-
nikacijskih vsebin: od nativnega govora, diskurza v skupini, intervjujev, pub-
licistike, mitov, legend, bajk, dokumentov, knjig, oglasov, medijskih objav, do
neverbalne komunikacije itd. Orodje med naštetimi formati in tipi komuni-
kacije omogoča primerjave tako na strani tvorjenja komunikacije (kodira-
nja) kot na strani sprejemanja (dekodiranja). 

Večina podatkov, ki jih imamo na voljo o človekovem mišljenju in člove-
kovem vedenju, je v taki ali drugačni obliki tekstov. Tekst je ustvarjen v aktu
pisanja, ki je oblika kognicije, ki z uporabo besed, fraz, stavkov in drugih
izraznih sredstev (risba, fotografija, video, avdio…) izkustvu ustvari pomen
(Bernard, 1998: 595). Pisanje je torej komponiranje sekvenc misli in idej v
simbolni formi na način, da sklop pomenov prenese izkustvo v ponovno
obravnavo, dopolnitev ali obdelavo. Postopki, vezani na proces analiziranja
tekstov, so zato metode za ugotavljanje ustvarjanja pomenov in vzorcev v za-
pisanem2 tekstu. 

Antropolog H. Russell Bernard posebej poudarja vpliv literarne analize
tekstov, analize bibličnih tekstov, študije avtorstva ali hermenevtike na razvoj
področja analize tekstov v kontekstu socioloških znanosti. Hkrati pa ta po-
dročja jasno ločuje od načel in tradicij, ki jih uporabljajo in razvijajo antropo-
logi in sociologi. V analizi tekstov razlikujemo dve tradiciji: lingvistično – ta
obravnava tekst kot objekt analize na sebi, in sociološko – ta ravna s tekstom
kot oknom v človekovo izkušnjo. Za nas je zanimivejša sociološka tradicija, v
katero se uvrščajo: analiza shem, teorija osnovanja, klasična analiza vsebine,
analiza semantičnega omrežja, kognitivno mapiranje in še nekatere druge.

Raziskovalci se glede epistemoloških vprašanj lahko identificiramo z
dvema usmeritvama: humanistično in pozitivistično. Prva obsega interpreta-
cijo in iskanje pomena. Druga vsebuje skrčenje teksta na izvedene kode, ki
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1 Kodiranje je prenos med dogodki zunanjega sveta in njihovega življenja kot percepcij, predlogov in

idej v sociokulturnem miljeju; kodiranje je proces, pri katerem zadnje velja in nadomešča prejšnje. Sistem

kodiranja ni le omrežje percepcij, je tudi sistem komunikacije. Kodiranje podeli sporočilu zunanji svet in

zmožnost posredovanja vsem, ki si delijo znanje o kodi. Kodiranje omogoča komunikacijo o svetu in obse-

ga dva prevoda: med svetom in kodo, ter enim uporabnikom kode z drugim uporabnikom. Sistem kodira-

nja lahko razumemo kot način, v katerem je univerzum objektov, relacij in dogodkov pretvorjen v komuni-

kacijske znake (Bateson, 1951: 175).
2 Antropologija je pisanje postulirala kot objektivizacijo govora. Pisanje omogoča sociokulturno od-

tujitev in odmik tako, da povzroča poenotenje in razvoj zavesti, znanosti in tehnologije v smislu enciklope-

dičnosti in sekvenčnosti. To je tehnika fiksiranja diskurza za kasnejšo analizo in prevajanje, ustvarjanja

kvazi ločenih svetov teksta, ki je zasenčila oralnost, ujeto v aktualnost okoliščine. Pisanje je tehnologija, ki je

socialnim institucijam v konkretnem času in prostoru dala nabor funkcij (hierarhije, izobraževanje), da se z

njo ustvarja partikularno ideološko realnost tistim, ki jo uporabljajo. V antropologiji pisanje ni razumljeno

le kot nevtralen medij prek katerega se širi znanje, dejstva in izkustva, ampak bolj kot okno v neodvisno

realnost, ki ima sebi značilno vedenje. (Goody & Watt, 1968: 57–58).



predstavljajo teme ali koncepte ter aplikacijo kvantitativnih metod za iskanje
vzorcev v relacijah med kodami (Bernard, 1993). Analitično orodje, ki ga
predlagamo, je razvito v medsebojnem prepletanju obeh usmeritev. V meto-
di, doslednosti in zanesljivosti se napaja iz pozitivizma, obenem pa ne izklju-
čuje intervala svobode in temeljne udeleženosti raziskovalca v vseh fazah
tvorjenja in interpretiranja analize tekstov in s tem so-ustvarjanja kulture. 

Raziskovanje teksta in odnosi z javnostmi

Predpostavljamo, da je pomemben, zunanji del delovanja služb za odno-
se z javnostmi usmerjen v so-vplivanje na produkcijo (pisanje) vsebine mno-
žičnih medijev. Te cilje službe za odnose z javnostmi uresničujejo s sistema-
tičnimi odnosi z mediji oziroma uredništvi. Produkcija tekstov je osnovna
dejavnost medijev, ki (ne)ohranjajo svojo funkcijo relativno avtonomnega
družbenega podsistema, ki (ne)deluje po sebi lastnih vzorcih. Ker je medij-
ski sistem pomemben socializacijski in kulturni dejavnik (agens) pri kon-
strukciji družbene realnosti, morajo korporacije s posebno pozornostjo
upravljati odnose z mediji. Atomiziranemu postmodernemu posamezniku
množični mediji predstavljajo osrednji vir za generiranje temeljnih percepcij
in predstav. Bralci oz. gledalci množičnih medijev si v interakciji z le-temi po-
rajajo pomemben del predstav o tematikah, s katerimi je korporacija pove-
zana, in s tem o korporaciji in njenih produktih, storitvah, regulatornem oko-
lju ter etično-moralnih izhodiščih njenega delovanja in potrošnje njenih
produktov ali storitev. 

Naloge komunikacijskega menedžerja, kot sta jih pri svojem raziskovanju
odkrila Betteke van Ruller in Dejan Verčič, lahko izpeljemo iz štirih vlog; sve-
tovanje, inštruiranje, konceptualiziranje in izvajanje. V kontekstu uporabe
predlagane metodologije posebej izpostavljamo vlogi svetovalca in inštruk-
torja. Prva se nanaša na analiziranje spreminjajočih se družbenih vrednot in
norm. Poleg tega svetovalec skrbi za razpravljanje o teh vprašanjih s člani v
organizaciji z namenom prilagajanja. Vloga inštruktorja pa se nanaša na izo-
braževanje članov organizacije za komunikacijsko kompetentno vedenje z
namenom odzivanja na družbene zahteve (Verčič & van Ruler, 2002: 751).
Komunikacijske vsebine, semantična polja, nativni in medijski diskurz pove-
zan z izdelki, storitvami in poslanstvom organizacije so primarni sistemi zna-
nja, ki morajo biti z ustreznimi podpornimi procesi integrirani v koncept
učeče se organizacije, ki je sposobna razumeti svoje deležnike in to razume-
vanje pretvarjati v vedenje. Verjamemo, da so predlagane analitične rešitve
lahko del takih komunikacijskih praks, ki sta jih Verčič in van Ruler poime-
novala refleksivni komunikacijski menedžment. V članku se osredotočeno
ukvarjamo z vprašanjem razvoja analitičnega pristopa na primeru analizira-
nja medijskih vsebin, uporabnega za delovanje služb za komuniciranje z jav-
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nostjo. Velik del učinka procesa odnosov z javnostjo je dejansko odvisen od
medijskih vsebin in oblik medijskega pojavljanja teh vsebin. Kot primer prek
katerega razvijamo analitični pristop, bomo uporabili zbirke medijskih
objav s specifičnimi semantičnimi in časovnimi omejitvami. 

Osrednja, vendar ne edina tehnika za ugotavljanje učinka komunikacij, ki
se uporablja v te namene, je merjenje mnenj, stališč, vrednot in percepcij. Pri
analizah medijskega pojavljanja, ki so danes sestavni del paketa ‘analitičnih
produktov’ v ponudbi kliping storitev, je za merjenje komunikacijske učin-
kovitosti najbolj uporabljana t. i. ‘content analysis’ oziroma analiza vsebine.
Metoda, ki jo v članku natančneje predstavljamo, torej Reprezentacijska
Analiza Medijskega Pojavljanja (RAMP), podobno kot analiza vsebine
spada v skupino kvantificiranih kvalitativnih metod. Obema metodama je
skupno, da poskušata iz kompleksnega in obsežnega gradiva abstrahirati
pomenske vzorce, ki predstavljajo lažje razumljive in determinirajoče sklo-
pe. Lahko rečemo, da RAMP predstavlja znotraj analitičnih pristopov kliping
analiz smiselno nadgradnjo analizi vsebine. Zato v nadaljevanju sumarno
najprej povzemamo analizo vsebine, da bi lažje razumeli analitični domet
reprezentacijske analize.

Analiza vsebine

Pojem »analiza vsebine« je leta 1910 prvič uporabil eden izmed očetov so-
ciologije, Max Weber, ki je na prvem srečanju nemškega sociološkega druš-
tva predlagal uporabo analize vsebine nemškega časopisja, kot pomembno
metodo za ugotavljanje njenega vpliva. Webrov predlog sicer takrat ni bil
sprejet, metoda pa je ostala (Krippendorf, 1980). Danes je analiza vsebine
raziskovalno orodje, s katerim določimo prisotnost določenih besed in kon-
ceptov v tekstu ali sklopih teksta. Raziskovalci kvantificirajo in analizirajo
prisotnost, pomene in relacije besed in konceptov in tako ustvarijo ugotovi-
tve – sklepe o sporočilih v tekstih, avtorjih, uredništvih, medijih, kulturi ter
prostoru in času, v katerih so sporočila nastala. Tekst predstavljajo knjige,
poglavja knjig, eseji, intervjuji, diskusije, naslovje v časopisu in članki, histo-
rični dokumenti, govori, formalni pogovori, oglaševanje, gledališče, nefor-
malni pogovori ali pravzaprav vsaka navzočnost jezikovanja.

Analiza vsebine temelji na kodiranju besed, kodiranju smisla besed, fraz,
stavkov, tematik in konceptov v izvedene kategorije, tako da jih lahko smisel-
no statistično upravljamo in na ta način generiramo spoznanja, zaključke in
povezave na novi ravni. Osnovna ideja je skrčenje informacij v tekstu na serijo
raziskovalnih spremenljivk, med katerimi se pregleda morebitne korelacije.

Analiza vsebine obsega dva temeljna koraka: (1) redukcijo simbolnih
artefaktov kot posledic človeškega vedenja v enote (kodirne spremenljivke)
urejene v matrike in (2) kvantitativno analiziranje matrike, da bi testirali

Martin ŽUŽEK-KRES, Janez KNE

TEORIJA IN PRAKSA let. 45, 6/2008

833



predpostavljene hipoteze. Matrika je ustvarjena z navezovanjem zbirke kod
na simbolne artefakte in s kontroliranjem zanesljivosti med analitiki pri tem
procesu (Riffe et al., 2005). Pri analizi vsebine predpostavljamo, da vsebinski
sklopi, ki jih komunikator posreduje, dosežejo večji vpliv na ciljne skupine,
če so bili objavljeni v medijih z večjo naklado, če je bil sklop objavljen v
notranjem formatu medija bolj izpostavljeno, če je bilo ključno sporočilo
objavljeno v naslovju, če vsebuje personificirane izjave, če vsebuje vizualno
konstrukcijo, če vsebuje personificirano mnenje, če je aktualizirano itd. Me-
toda merjenja mora upoštevati splet dosega, površine/trajanja in kognitivnih
dejavnikov konkretne medijske objave, ki omogočajo mentalno procesira-
nje posredovanih in ciljanih vsebinskih sklopov. Vsebinski sklopi vsebujejo
mnenja, stališča, percepcije. Ta vsebina dominantno sooblikuje orientacije
in vzorčne drže vseh, ki se vsak dan v nezavednem ritualiziranem vsakdanu
prepuščamo (in)formiranju.

Potrebno pa je poudariti, da je pri analizi vsebine interpretacija in reduk-
cija pomenskih sklopov odvisna od spoznavnoteoretskega okvira, ki ga razi-
skovalec uporabi. Na tej točki se vzpostavlja razlika med vsebino analize in
eksploratorno analizo semantičnih omrežij. Če je pri analizi vsebine sestavni
del končnega rezultata tudi raziskovalčev (ali naročnikov) kodirni sistem, ki
določa, kako obravnavani tekst ‘beremo’, se eksploratorna omrežna analiza
temu poskuša izogibati. Če analizo vsebine predvsem zanima jakost (frek-
venčnost, količinskost, naklada) objav, se eksploratorna omrežna analiza uk-
varja s tem, kakšni reprezentacijski vzorci se vzpostavljajo pri vsebinskem
omrežju obravnavanega medijskega pojavljanja. Analizo vsebine zanima, ko-
liko se v tekstih pojavljajo pomenski vzorci, ki jih določi raziskovalec. Na
drugi strani pa eksploratorna omrežna analiza poskuša iz samega besedišča
nekega medijskega pojavljanja izluščiti, kakšni pomenski vzorci v medij-
skem pojavljanju obstajajo in kdo so nosilci teh reprezentacijskih shem. Z
eksploratorno omrežno analizo poskušamo ugotoviti, kakšni pomenski
vzorci so bili prisotni pri avtorjih (novinarjih, urednikih) ali nosilcih (npr.
intervjuvancih) medijskih vsebin.

Pri oblikovanju aplikativne oblike eksploratorne omrežne analize, prire-
jene za reprezentacijsko analizo medijskega pojavljanja, smo konceptualno
segli tudi na področje analize kulture (culture analysis). Analiza kulture kot
epistemološki in metodološki koncept sicer presega okvir pričujočega član-
ka, a predstavlja metodo na področju aplikacije kulturne antropologije za
raziskovanje potrošnikov. Analiza kulture je preučevanje povezav in ločitev,
podobnosti in kontradiktornosti med tistim, kar je bilo rečeno in storjeno.
Cilj te analize je upoštevanje vsakega detajla, delčka ideje, da bi tako našli vse
možne metafore, pomene ali povezave. Z uporabo vsakršnega kulturnega
znanja si tako pomagamo pri interpretaciji fenomenov, ki jih preučujemo
(Sunderland et al., 2007: 62).
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Eksploratorna analiza semantičnega omrežja kot reprezentacijska

analiza

Za analizo vsebine je torej značilno, da se pomembnost izpostavljanja
(redukcija) določenih pomenskih sklopov udejanja na ravni medijske repre-
zentativnosti. Redukcija pomenskih sklopov ne temelji toliko na vsebini kot
na analizi komunikacijskega dosega določenih vsebin. Na drugi strani pa
reprezentacijska analiza k analizi vsebin pristopa drugače: ne zanima je toli-
ko komunikacijski vidik, ampak v samem tekstu prisotne in iz obravnavanih
vsebin izhajajoče reprezentacijske sheme, ki pomensko (semantično) deter-
minirajo sicer komunikacijsko prevladujoče pomene. Reprezentacijska ana-
liza si iskalnih pojmov ne postavlja vnaprej, ampak eksploratorno detektira
pomenske zgostitve, ki potencialno kažejo ključne pomenske sklope, ne
glede na komunikacijsko realnost medijskega objavljanja. Pri tem moramo
dodati, da sta prikaz in rekonstrukcija teksta sinhrone narave, v kateri je ling-
vistični fenomen opazovan z določene točke v času. To ne pomeni, da razvo-
ja fenomena skozi čas ni mogoče upoštevati, vendar se z njim v tem okviru
ne ukvarjamo.3

Reprezentacijska analiza temelji na prepletu sociokulturnih in kognitiv-
nih konceptov in s tem pripada interdisciplinarnemu področju kognitivne
antropologije, kjer je shema pojmovana kot ključen pomenski sklop (včasih
se uporabljata tudi izraza shemata ali skript), ki omogoča, da se posamezni-
ki znotraj iste kulturne ali komunikacijske skupine razumejo. Roy D’Andra-
de, danes pa predvsem Claudia Strauss in Naomi Quinn, so morda najbolj
eksplicitno izpostavljene kognitivno-antropološke reference. Quinn (1987,
1992) se osredotoča na analizo intervjujev in poskuša »exploit clues in ordi-
nary discourse for what they tell us about shared cognition—to glean what
people must have in mind in order to say the things they do« (Quinn, 1997:
140). Nestor kognitivne antropologije, Roy D’ Andrade pa zapiše (1991: 294):
»perhaps the simplest and most direct indication of schematic organization
in naturalistic discourse is the repetition of associative linkages«. Reprezen-
tacijska analiza je v svojem jedru strukturalistična. Njen cilj je izpostavitev
ključnih pomenskih struktur, vzorcev, ki determinirajo razumevanje sveta.
Osnovna predpostavka reprezentacijske analize temelji na tem, da ljudje za-
radi kognitivnih omejitev (na tem mestu še vedno ostaja aktualen temeljni
kognitivistični članek Miller, 1956) razmišljamo in komuniciramo prek po-
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zbira njihova pričevanja; da bi dognali, koliko je kaj realnost, je treba in je zadosti ugotoviti, koliko obsta-

ja za zavest subjektov. Narobe pa mora diahronično jezikoslovje razločevati dve perspektivi, prvo, ki je

prospektivna in gre s tokom časa, in drugo, retrospektivno, ki gre proti časovnemu toku. Predmet sinhronič-

nega proučevanja ni vse, kar je hkratno, temveč celota dejstev, ki ustreza vsakemu jeziku« (Saussure, 1997:

104–105).



menskih poenostavitev: » Schema analysis combines elements of the lingui-
stic and sociological traditions. It is based on the idea that people must use
cognitive simplifications to help make sense of the complex information to
which they are constantly exposed« (Ryan & Bernard, 2000: 769; glej tudi Cas-
son, 1983: 430). Sheme so reducirani pomenski sklopi, ki si jih predstavlja-
mo kot informacijsko podlago avtomatiziranim kognitivnim procesom, ki se
jih ne zavedamo, imajo pa ključen vpliv na naše – posameznikovo – vedenje,
védenje in doživljanje obojega (Mandler, 1984, 55–56). Sheme se vzpostav-
ljajo tako na ravni kulture kot tudi na ravni posameznika. ‘Resnica’ oziroma
posameznikovo prepričanje pa se vzpostavlja v situacijskih interakcijskih
presečiščih med kulturno vzpostavljanimi reprezentacijami in posamezni-
kovimi reprezentacijami. V posameznikovem mentalnem aparatu gnezdijo
znaki v določenih povezavah z drugimi znaki kot obsežen, v kulturi (tudi
prek medijev) realizirani shematski potencial. Toda ta obsežna potencialna
shema subjektivno v celoti nikoli ni realizirana. Kulturno vzpostavljano re-
prezentacijsko omrežje (shema) je zgolj potencialna celota, iz katere posa-
meznik subjektivno generira lastne reprezentacijske sheme, ki predstavljajo
pomensko (semantično) opredeljujočo strukturo v trenutku subjektovega
intencionalno (motivacijsko) determiniranega priklica sistema znakov, ko se
posameznik (subjekt) nahaja v določenem javnem (realnem, situacijskem)
in zasebnem (imaginarnem) kontekstu. Claudia Strauss (1992) je to pomen-
sko strukturo, ki je osrednja analitična metafora v kognitivni antropologiji,
poimenovala ‘semantic networks’. Odtod tudi konceptualna in poimenska
podlaga za eksploratorno analizo semantičnih omrežij (EASemO, glej Žu-
žek-Kres, 2005), iz katere izhaja RAMP – reprezentacijska analiza medijskega
oojavljanja. Z razliko od nekaterih drugih uveljavljenih analiz ‘semantičnih
omrežij’ (MultiNet, SnePS) EASemO poskuša aplicirati analitične procedure,
ki sicer izhajajo iz eksploratorne analize socialnih omrežij (EASO) na podla-
gi računalniškega programa Pajek. Reprezentacijska analiza medijskega po-
javljanja (RAMP), ki jo v nadaljevanju predstavljamo, je aplikativna oblika
EASemO in posebej prirejena za analizo medijskega pojavljanja.

Študij primera

Postavlja se vprašanje, kako metodološko pristopiti k teoretsko sicer vab-
ljivemu mrežnemu razumevanju vsebin. ‘Semantic networks’, ‘shared cogni-
tions’ in podobno so obetajoči izrazi, ki pa večinoma ostajajo konceptualni
besednjak sicer subjektivnemu interpretativnemu analitičnemu raziskovanju.
Vnašanje omrežnega razumevanja komuniciranih vsebin pa nas napeljuje k
temu, da poskušamo vsebinska omrežja analizirati s pomočjo matematizira-
nih analiz omrežij, prek katerih bi lahko bolj standardizirano in na podlagi
teorije analize omrežij oblikovali analitične korake pri iskanju determinirajo-
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čih pomenskih sklopov znotraj obravnavanega gradiva. Omrežno razumeva-
nje vsebin predstavlja podlago za aplikacijo računskih postopkov omrežnih
analiz. S transformacijo tekstovnega gradiva v omrežje je omogočena pretvor-
ba kvalitativnih podatkov v kvantificirano obliko. S tem pa interpretacija in
redukcija pomenskih sklopov nista več odvisni od bolj kot ne subjektivnega
spoznavnoteoretskega okvira raziskovalca, ampak se omejita na matematizi-
rana pravila analize omrežij: »… example makes abundantly clear the value of
turning qualitative data into quantitative data: Doing so can produce infor-
mation that engenders deeper interpretations of the meanings in the original
corpus of qualitative data. Just as in any mass of numbers, it is hard to see
patterns in words unless one first does some kind of data reduction« (Ryan &
Bernard, 2000: 778). Ključni analitični smisel reprezentacijske analize, ki de-
terminira RAMP, je realizacija matematizirano kontrolirane redukcije obsež-
nih tekstualnih podatkov v manjše število ključno opredeljujočih pomenskih
shem: »These reductions make it easy for researchers to identify general pat-
terns and make comparisons across texts« (ibid: 779).

Matematične definicije omrežje pojmujejo kot množico točk, ki predstav-
ljajo izbrane enote, in množico povezav, ki predstavljajo odnose med enota-
mi. Tako pri točkah kot tudi pri povezavah pa lahko dodatno poznamo tudi
njihove (kvalitativne) lastnosti. Omrežje je dejansko oblika grafa s spremlja-
jočimi podatki o lastnostih teh točk in povezav (Nooy et al., 2005). Če imamo
podatke v omrežni obliki, potem lahko apliciramo analitične postopke, ki
izhajajo iz matematičnih osnov omrežij. Poleg tega v kognitivni psihologiji
teorija semantičnih mrež (Semantic Network Theory; Quillian, 1967, 1968;
Schank, 1975; Simmons, 1973; Woods, 1985) predstavlja eno od najširše apli-
ciranih teorij. Tako kot pri matematičnem razumevanju so tudi kognitivne
mreže grafične predstavitve, ki se jih uporablja kot predloge za razumevanje
kognitivnih procesov in njihovo informacijsko simulacijo. Dva elementa sta
osnovna gradnika semantičnih mrež: koncept in povezava (asociacija). Kon-
cept je definiran kot katerakoli enota mišljenja oz. informacija (Genter,
1978). Koncepti pa so med seboj povezani: asociacije so najbolj posplošena
predstava o povezavah med koncepti (kot smo videli aplicirani tudi znotraj
kognitivne antropologije, glej D’ Andrade, 1991). Nekateri avtorji tudi pove-
zave razumejo kot posebno obliko konceptov (Sowa, 1984). Semantične
mreže so torej zgrajene iz objektnih in povezovalnih konceptov. Objektne
koncepte lahko razumemo kot množico omrežnih točk, povezovalne koncep-
te (oz. asociacije) pa kot množico omrežnih povezav. Na jezikovni ravni
samostalniki in pridevniki označujejo objektne koncepte oziroma točke,
glagoli pa povezovalne koncepte oziroma povezave. Na ta način potencial-
no lahko transormiramo vsebinska gradiva v omrežno obliko in uporabimo
matematizirane postopke analize omrežij. S tem pa analiza vsebine postane
reprezentacijska analiza.
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Reprezentacijska analiza medijskega pojavljanja (RAMP)

Za prikaz aplikacije reprezentacijske analize kot načina analiziranja me-
dijskega pojavljanja smo uporabili kliping material z iskalnim pojmom
»prehlad« za obdobje meseca januarja 2008 v slovenskih množičnih medijih.
Analiziranih je bilo 29 člankov. Besedišče omrežja obsega 135 različnih
besed. Mreženje in omrežne analize smo izvajali s pomočjo programa
Pajek.4 Vsi opisani koraki se nanašajo na postopke in ukaze, kakor jih najde-
mo v omenjenem računalniškem programu.

Transformacija vsebin v omrežno obliko

Transkriptivna transformacija teksta v omrežno obliko je prvi korak
RAMP. Osnovno pravilo izhaja iz konceptualizacije semantičnih shem in
smo ga že omenili: samostalniki in pridevniki označujejo objektne koncep-
te oziroma točke, glagoli pa opredeljujejo, katere točke povezujemo med
seboj. Tekom mreženja ločimo besedišča, ki so medijsko reprezentirana kot
naslovi, besedišča, ki izhajajo iz podnaslovov in besedišča, ki so del člankov
oz. jih preberemo iz pripadajočega vizualnega materiala. Če se neka beseda
večkrat pojavlja v različnih slovničnih oblikah (npr. ‘prodati’, ‘s prodajo’),
smiselno izberemo neko obliko iste besede in jo uporabljamo kot eno-
značno.

Analitična obravnava omrežja

V analitičnem smislu se z reprezentacijsko analizo tekstualnih vsebin me-
dijskega pojavljanja lotimo z dvema zaporednima korakoma: (1) najprej
opredelimo jakostne skupine medijske izpostavljenosti besediščnih omre-
žij; (2) v drugem koraku reduciramo vsebine na pomenske sklope s pomoč-
jo detekcije reprezentacijske kohezivnosti.

Jakost medijske izpostavljenosti besedišča je definirana s frekvenco po-
javljanja besede ali besedišča in s številom navezav te besede na druge bese-
de obravnavanega medijskega pojavljanja. V tem koraku nas torej zanima,
katere besede ali v besediščno mrežo povezane besede dominirajo v obrav-
navanem medijskem pojavljanju. Ko izvajamo mreženje, se šteje, v kolikšni
meri je neka beseda v navezavi z drugimi besedami in kolikokrat se pojavi.
Dominantnost besed se na tak način v programu Pajek avtomatično določa
s ‘particijsko stopnjo’. Poleg frekvenčnega štetja lahko medijsko dominant-
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nost besed tudi ponderiramo glede na to, ali se beseda pojavlja v naslovu,
podnaslovu ali tekstu.

V našem primeru smo z izvedbo ukazov v programu Pajek (Net > Parti-
tions > Degree > All; Vector > Tranform > Multiply by; Draw > Draw-Partition-
Vector) dobili slikovni rezultat celotnega omrežja obravnavanega medij-
skega pojavljanja (slika 1). Velikost krogov nakazuje raven medijske
izpostavljenosti posameznih besed. Ta slika je seveda vizualno prezapletena
in je ne uporabljamo kot rezultat, kaže pa, da nekatere besede bolj izstopajo
kot druge.
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Slika 1

V naslednjih korakih izpeljemo particijske ekstrakcije smiselnih podsku-
pin (Pajek: Operations > Extract from Network > Partitions). Izkušnje kažejo,
da se particijske vrednosti (partition degree) po celotnem omrežju pri anali-
ziranju medijskih tekstov razdelijo v vsaj tri ločene skupine: skupina z najviš-
jimi particijskimi vrednostmi predstavlja najbolj izpostavljeno in frekvenčno
največkrat pojavljano reprezentacijsko besedišče (slika 2).

Ta skupina je v našem primeru izrazito odstopala, saj je imela particijske
stopnje med 18 in 23. Naslednja particijska stopnja, ki smo jo uvrstili v drugo
skupino, je bila 13. Med 13 in 18 je bilo torej 5 particijskih stopenj, ki jih v
naši mreži sploh ni bilo. Zato smo skupine lahko nedvoumno ločili. Značil-
nost te skupine je tudi, da je sestavljena iz besed, ki so definirale naslove v
medijskem pojavljanju (besede z velikimi črkami). V tej ekstrakciji, ki jo pri-
kazuje slika 2 in ki jo lahko beremo kot medijsko najbolj izpostavljeno med-



sebojno povezano besediščno omrežje, lahko vidimo, kako so bili članki, ki
smo jih izbrali prek ključne besede ‘prehlad’, na ravni naslovov dominantno
reprezentirani s shemo, ki prehlada sploh ne vključuje, umešča pa gripo
med dva farmacevtsko-zdravniška pristopa: med cepljenje in zdravila (virusi
pa so seveda skoraj samoumeven del sheme o gripi).

Druga skupina je bila sestavljena iz točk (besed), ki so imele particijske
stopnje od 8 do 13 (slika 3). Ta skupina predstavlja osrednjo reprezentacij-
sko strukturo, ker gre za preplet še vedno precej dominirajočega besedišča,
ki pa je z razliko od prejšnje sheme (slika 2) bolj raznovrstno sestavljena iz
naslovnih besed (velike črke), podnaslovnih besed (velike začetnice), kakor
tudi iz besed tekstualnih delov (male črke).

Slika 3
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V tej shemi zasledimo izhodiščni pojem ‘prehlad’, prek katerega smo za-
jemali kliping material. In če se je pri najbolj dominantni shemi (slika 2) po-
kazalo, da jo opredeljujeta dva farmacevtsko-zdravniška pristopa, potem pri
sliki 3 vidimo, da se je pri obravnavanem medijskem pojavljanju pokazalo,
da se prehlad reprezentacijsko povezuje s konceptom ‘samozdravljenja’.

V naslednjem koraku obe shemi (v danem primeru točke s particijskimi
stopnjami od 8 do 23), ki skupaj tvorita prevladujoči del celotnega medijske-
ga pojavljanja, vizualiziramo kot enotno reprezentacijo (slika 4).

Slika 4

Ta rezultat še jasneje izpostavlja tisto, kar se je pri sliki 2 zgolj nakazovalo.
V medijih sta se v januarju 2008 vzpostavljali dve gripi: ena reprezentacija
gripe se je povezovala s cepljenjem; druga reprezentacija gripe pa se je nave-
zovala na možnost samozdravljenja. Zgovorno je tudi, da se z vključitvijo
particij, ki pripadajo drugi particijski jakostni skupini (particije 8-13), repre-
zentacijska veja okoli cepljenja vsebinsko ni skoraj nič bolj definirala. Na
drugi strani pa se pojem gripa navezuje na obsežno reprezentacijo, ki jo po-
mensko determinira preplet, ki ga lahko opišemo kot »prehlad, ki ga je mo-
goče samozdraviti s sredstvi (zdravili), ki blažijo znake oz. simptome«.

Dosedanje prikaze omrežne obravnave medijskega pojavljanja nam ka-
žejo, da se je v januarju 2008 gripa v medijih na ravni naslovov celo domi-
nantno povezovala s cepljenjem. Toda v vsebinskem smislu se gripa v istem
medijskem pojavljanju navezuje na reprezentacijsko shemo, ki gripe ne defi-
nira kot bolezni ampak kot prehlad, ki ga lahko samozdravimo.
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Te trditve moramo in lahko preverimo še z drugimi načini omrežne anali-
ze. Če so trditve v zgornjem odstavku smiselne, bi se namreč moralo to odra-
žati na ravni intenzivnosti medsebojne prepletenosti tega besedišča. Če je
torej res, da se v medijih gripa bolj povezuje z reprezentacijsko mrežo, ki jo
definira prehlad, ne glede na to, da je na ravni naslovov člankov povezava
gripe in cepljenja izrazitejša, potem bi se morala pokazati visoka mera med-
sebojne prepletenosti besedišča, ki prepleta prehlad, samozdravljenje in
gripo.

Detekcija reprezentacijske kohezivnosti je postopek ugotavljanja ravni
medsebojne omrežne prepletenosti. To v omrežnih analizah opredeljujemo
kot mero kohezivnosti. Če smo v prvem sklopu obravnavali reprezentacij-
sko mrežo na ravni jakosti medijske izpostavljenosti, potem nas v tem dru-
gem sklopu zanima, katero besedišče je bilo medsebojno vsebinsko najbolj
tesno prepleteno in zaradi tega (in ne zaradi jakosti medijskega pojavljanja)
predstavlja neko »skrito shemo«, ki pa zaradi kohezivnosti predstavlja alter-
nativo tistim shemam, ki svojo vplivnost vzpostavljajo na ravni medijske
izpostavljenosti.

Za detekcijo najbolj medsebojno prepletenega omrežja smo aplicirali t. i.
‘k-core’ koncept (slika 5; Pajek: Net > Partitions > Core > All; Operations > Ex-
tract From Network > Partitions (izberemo najvišjo dobljeno particijo);
Draw > Draw-Partition).

Slika 5



Slika 5 predstavlja ekstrakcijo najbolj prepletenega omrežja v obravnava-
nem medijskem pojavljanju. Vidimo, da se znotraj te najbolj kohezivne
sheme nahajata tako gripa kot tudi prehlad, cepljenja pa v tej mreži ni! S tem
se potrjujejo prejšnje ugotovitve, da se gripa bolj navezuje na shemo, ki je v
povezavi s prehladom kot pa na shemo v povezavi s cepljenjem.

Za bolj natančen vpogled v odnos med gripo in prehladom lahko izvede-
mo iskanje povezav med tema dvema pojmoma na ravni dovoljene medse-
bojne oddaljenosti. V tem primeru oddaljenost treh korakov apliciramo
zato, ker se to sklada s kognitivno psihološkim koncipiranjem smiselnosti
asociacijske oddaljenosti (slika 6; Pajek: Net > Paths between two vertices > Li-
mited Lenght Paths; Draw > Draw-Partition).

Slika 6

Slika 6 nam kaže, katero je tisto besedišče, ki pomensko zbližuje prehlad
in gripo. Rezultat se do določene mere ponavlja z že ugotovljenim, poleg
tega pa je izstopajoča povezava, ki lahko nakazuje potrošnikovo vedenje: re-
ševanje gripe s samozdravljenjem brez obiska zdravnika (zdravniki niso
nujni). Ko pridemo do te ugotovitve, se postavlja vprašanje, katera točka ali
lokalno podomrežje definira reprezentacijo okoli tega, da zdravniki niso
nujni. Če se vrnemo na sliko 5, vidimo, da zdravniki niso nujni v shemat-
skem kontekstu samozdravljenja, ko se lahko uporablja zdravila brez recep-
ta. Zdravniški recept je zato morda pomembna točka za nadaljnje eksplora-
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cije obravnavane reprezentacije. To lahko analiziramo s konceptom ‘soseds-
tva’ okoli izbrane točke (Pajek: Net > k-Neighbours > All; Operations > Extract
from Network > Partitions). Tako na dobljeni sliki 7 vidimo, da je ‘sosedstvo’
okoli točke zdravniški recept strukturirano kot zaokroženo omrežje. Zato se
v našem primeru, ko smo prej videli, da zdravniški recept indicira vedenjsko
shemo potrošnika, ta točka kaže kot ključna beseda, prek katere se povezu-
jeta dva pristopa k obvladovanju gripe: ‘cepljenje’ in ‘zdravila’.

Slika 7

Na eni strani nam je eksploratorna obravnava omrežja izpostavila sheme,
kjer gripo lahko samozdravimo z zdravili brez recepta in mimo zdravnikov: ta
shema se je pokazala zaradi najvišje stopnje kohezivnosti kot ključna repre-
zentacija. Na drugi strani pa sta cepljenje in zdravila, kjer je ključna reprezen-
tacijska (in potencialno vedenjska) točka pridobitev zdravniškega recepta.
Zdravniški recept je reprezentacijsko tista točka, ki predstavlja vedenjsko
oviro v primerjavi z možnostjo samozdravljenja z zdravili brez recepta. Iz do
zdaj ugotovljenega lahko sklenemo, da je v tekstih, ki so se medijsko pojavlja-
li tekom obravnavane periode (januar 2008), prihajalo do dveh reprezentacij-
skih sopostavitev: (1) medijsko eksplicitnejša je bila reprezentacija, ki je gripo
povezovala s cepljenjem in zdravili, toda na vsebinski ravni je ne glede na to
(2) prevladujoča tista reprezentacija, ki gripo definira kot obliko prehlada in
jo zato lahko samozdravimo z zdravili brez recepta.

Martin ŽUŽEK-KRES, Janez KNE

TEORIJA IN PRAKSA let. 45, 6/2008

844



Sklepi, oziroma, kaj si z reprezentacijsko analizo lahko pomagamo

v odnosih z javnostmi

Pri RAMP je opisano reprezentacijsko sopostavljanje osrednji cilj analize.
Interpretativna pozornost je usmerjena v določanje skladnosti med obema
reprezentacijskima rezultatoma. Če bi npr. oba eksploratorna pristopa dala
skladne reprezentacije, bi to pomenilo, da je tako medijsko eksplicitni del
kot tudi vsebinski del istih sporočil skladen in javnosti sporoča enoznačno
shemo o določenem vprašanju. Po drugi strani pa, ko dobimo neskladen re-
zultat, kot smo ga npr. v predstavljenem primeru o prehladu, to nakazuje, da
je bila neka shema zaradi uredniških politik, časovnih dogodkov ali oglaše-
valskih akcij objavljana tako, da je prihajalo do neskladja med najbolj ekspli-
citnimi objavami (naslovi, podnaslovi, slike, oglasi) in pretežnim vsebinskim
delom istih objav. Pri produkciji medijskih objav je na nevsebinske dele laže
vplivati, tekstualni deli pa se producirajo na ravni občih, kolektivno zasidra-
nih shem. Z razliko od analize vsebine, ki se ukvarja predvsem s tem, kako se
nek pojem v medijih pozitivno ali negativno pojavlja, nam omrežna analiza
omogoča, da detektiramo »skrite« sheme, ki odražajo nezavedno reprezenta-
cijsko strukturo agensov produkcije medijskega pojavljanja. Za vse, ki se
ukvarjajo z odnosi z javnostmi, je zelo pomembno poznavanje teh »skritih«
in medijsko manj eksplicitnih, vendar shematsko bolj kohezivnih shem. Us-
pešna komunikacija s producenti medijskega objavljanja se začne takrat, ko
so tudi skrite tekstualne reprezentacije skladne s predstavami odgovornih z
odnosi z javnostmi. Če se spet vrnemo k predstavljenemu primeru: četudi se
zdi, da so se pri našem primeru ‘producenti’ medijskih vsebin trudili vzpo-
staviti povezavo med gripo in cepljenjem ter zdravili (zato so to besedišče
pozicionirali v naslove), je v celoti tekstov vseeno kohezivnejše prevladovala
reprezentacija, ki sugerira potrošnikovo (bolnikovo) vedenje, ki se izogiba
cepljenju in rajši poseže po zdravilih brez recepta in se tako samoozdravi
gripe. Reprezentacijska analiza nam daje vpogled v tista reprezentacijska
področja, ki so medijsko manj izpostavljena, a velikokrat zaradi svoje prikri-
tosti in implicitnosti še bolj opredeljujoča. Reprezentacijska analiza omogo-
ča, da ocenimo, kdaj je neko medijsko pojavljanje na eksplicitni ravni dru-
gačno od implicitnih shem, ki vplivajo na produkcijo medijskih vsebin in so
obenem tudi indikator kolektivne perceptivne sheme.

Reprezentacijska analiza in analiza vsebine se ne izključujeta. Dejansko
sta komplementarni, ker vsaka zase pokriva svoje polje istih medijskih vse-
bin in istega medijskega pojavljanja. Zato je načrtovana usmeritev prihodnje-
ga razvoja v prepletu obeh pristopov. Poleg tega predlagana metodologija
lahko predstavlja analitični most med različnimi »oddelki« znotraj tržnega
komuniciranja. »Skupni imenovalec« obeh pristopov omogoča poglobitev
razumevanja in učenja o (ne)zavednih aspektih transmisije kulture med raz-
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ličnimi strukturami deležnikov v korporativnem komunikacijskem procesu,
procesih menjave in predvsem v njeni veliki (ne)odgovornosti pri pomeno-
tvorju in s tem predstavam o svetu. Analitičnega procesa ne smemo razume-
ti kot metaforo »mehanizma« ali oddaljenega hladnega pogleda skozi klju-
čavnico v svet »na sebi«, ampak kot dialog, v katerem se ustvarjajo nova
spoznanja, odgovornost za svetove, ki jih živimo in jih s tem soustvarjamo. 
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